
CorelMOSAIC Help Contents
Help topics for CorelMOSAIC are divided into four categories represented by the icons below.

To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the category you want then
press ENTER. For more information on using Help, choose the Using Help icon or press F1. To return to this screen, select the 
Contents button at the top of the Help window.

    



Restore command (Control menu)

Returns the active window to the size and location it had before you chose the Minimize or the Maximize 
commands from the Control menu.

You can also restore a window by clicking on its Restore button.

· This command will not affect a window moved or resized with the Move or Size commands in the 
Control menu.



Move command (Control menu)

Allows you to move the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.
· You can also use this command to move Application icons and dialog boxes that have a Control 

menu.



Size command (Control menu)

Allows you to resize the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.



Minimize command (Control menu)

Shrinks the active windows to a small icon at the bottom of the screen.

· Using the Minimize command in the Control menu is equivalent to clicking on the Minimize button 
with the mouse.

· You can use the Restore command in the Control menu to restore the minimized window to its 
former size.



Maximize command (Control menu)

Expands the active window to fill the entire screen.

· Using the Maximize command in the Control menu is equivalent to clicking on the Maximize button 
with the mouse.

· You can choose the Restore command in Control menu or click on the Restore button to return the 
window to its former size.



Close command (Control menu)

Closes the active window or dialog box. If you have made changes to the current drawing, a dialog box 
appears asking you whether you want to save the drawing.

· Closing Mosaic is the same as choosing Exit from the File menu.
· Double-clicking on the Control Menu box is equivalent to choosing the Close command.



Switch To command (Control menu)

Opens the Task List which lists all the applications currently running on your system.

Dialog Box Options

Switch To
Opens the selected application.

End Task
Closes the selected application.

Cancel
Closes the Task List.

Cascade
Overlaps all open applications so that their Title bars are visible.

Tile
Sizes all open applications to fit on the screen.

Arrange Icons
Arranges the icons of all minimized applications evenly across the bottom of the screen.



New Catalog/Library command (File menu)

Creates a new catalog or library master file for storing thumbnails of associated files or for archiving files. 
If you select catalog, the master file will contain thumbnails but not the actual files. If you select library, the
master file will contain archived versions of the original files. As a general rule, when you wish to create a 
new library, ensure that there is free space available on your system equal to the total size of all the files 
you want to archive. (See Disk Space Requirements for Library files.)

Dialog Box Options

File Name
Displays a list of all library or catalog names in the current directory. Libraries have a CLB extension 
after their filename, catalog have a CLC extension.    

Directories
Displays a list of directories where you can place your new library or catalog. Double-clicking on a 
directory will select it, display all related subdirectories, and list all library names in the File Name box.

List files of Type
Displays the two file formats available for selection, Corel Catalog File or Corel Library File. Choose 
the format according to the master file you wish to create.

Drives
Lists the drives you can choose from. Click on the arrow to the right of the Drives box to view the 
range of options.

Description
Allows you to add a user-definable text string to a catalog.



Open Catalog/Library (File menu)

Opens an existing catalog or library master file and displays the thumbnails of each file organized within.

Dialog Box Options

File Name
Displays a list of all catalogs or libraries in the current directory. Double-click on a library or catalog 
name and all thumbnails for the files within the library or catalog will be displayed in the file display 
screen.

Directories
Displays a list of directories for selecting catalogs and libraries. Click on a directory, select the catalog 
or library you wish to open, choose OK, and the thumbnails of the library or catalog will be shown in 
the file display screen.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Displays the two file formats available for selection, Corel Catalog File or Corel Library File. Choose 
the format according to the master file you wish to open.

Drives
Lists the drives available for selection.

Find >>
Searches a catalog or library for files that contain specific keywords (indexing terms) and displays their
thumbnail images in the file display screen. See Keyword Search Dialog box.



Disk Space Requirements for Library files

When you create a new library, CorelMOSAIC does not tamper with your original files. As you add files to 
the library, CorelMOSAIC is making an archived copy of each. This means you must temporarily reserve 
additional space on your hard drive for the library. Once the library has been created, and you have 
checked to ensure all files were successfully archived, you may delete the original files.

Whenever you update a library file in CorelMOSAIC by adding or deleting a file, the program makes 
copies of your original library files and then uses these copies for the updates you request. Once the 
updates are complete, the updated files overwrite your original library files to complete the process.

If an error (for example, a bad disk sector error) should occur in this final stage, your original library files 
may only be partially overwritten and thereby rendered useless. This is rare, but it can happen. If it does, 
you can use the updated copies located in the directory you specified. (NOTE: If insufficient space exists 
in this directory, CorelMOSAIC will create the updated copies either on your TEMP drive or in your 
Windows directory.)

The copies will have the same names as the original but with .~LB extensions. So that CorelMOSAIC will 
recognize the files as library files, you'll need to change the extensions to CLB. 

Using a RAM drive as your TEMP drive
If you're using a RAM drive as your TEMP drive any files--including library files CorelMOSAIC creates--will 
disappear when you turn your computer off or if you're forced to reboot.

If you are building large libraries, this is a good reason not to use RAM for your TEMP drive. Instead, 
assign it a directory on one of your physical drives that has at least several megabytes of free space 
available. You'll also have to change the appropriate entry in your AUTOEXEC.BAT file to let your system 
know exactly where your TEMP drive is.

Creating a library while running MS-DOS 6
If you want to save space on your hard drive, it is important to note that files archived using MS-DOS 6 
compression will not be further compressed when placed in a library.



View Directory command (File menu)

Allows you to select a directory containing graphics files for viewing in the file display screen. You can 
also search for specific files by keywords and choose the order (by name or date) the images will be 
displayed in.

To help you select files, thumbnails of your graphics files will be displayed in the file display screen. If the 
file is not a graphic file, but is a file type recognized by CorelMOSAIC, the icon representing the program 
it was created in will be displayed. If a directory contains files in unrecognized formats you will see a 
symbol instead of a thumbnail or program icon. 

indicates that the file is in a format that CorelMOSAIC does not recognize. If CorelDRAW 
supports the format, you can still import, export and print the file via CorelDRAW.

Dialog Box Options

File Name
Displays a list of all files of a particular file format in the current directory which can be chosen in the 
List Files of Type box.

Directories
Displays a list of directories for selecting graphics files for viewing. Click on a directory, choose OK, 
and all files of a given format within that directory will be shown in the file display screen.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Lists all the file formats available for selection. Click on the arrow button to view the range of file types.

Drives
Lists the drives available for selection.

Options >>
Sort by Displays the options for organizing your thumbnails in the file display screen. You 

can sort by file name or file date. 

Subdirectories When selected, CorelMOSAIC searches the current directory and all directories 
below it for graphics files of a specified file format. Choose the subdirectories option,
click on a directory in the Directories box, and click on a file type in the List Files of 
Type box. Click on OK, and all files within the directory and any subdirectories 
beneath it of a chosen file format will be shown in the display screen. 

Preview When enabled, shows a thumbnail image of the graphics file highlighted in the File 
Name box.

Keywords Displays the indexing terms associated with a selected CorelDRAW file. 

Notes Displays the annotations associated with a selected CorelDRAW file.

Fonts Displays the names of the fonts used in a selected CorelDRAW file.

Find Searches a directory for CorelDRAW files that contain specific keywords (indexing 
terms) and displays their thumbnail images in the file display screen. See Keyword 
Search Dialog box.

Tip
If you are viewing a directory containing a large number of files, clicking on the window as



the files are being loaded will halt the display. When you are ready to see the rest of the 
files, hitting the ESC key will continue the display.



Delete Catalog/Library command
Allows you to delete a catalog or library you have created.
NOTE: CorelMOSAIC displays a confirmation dialog box before deleting the selected file(s). You can 
choose not to have this dialog box appear, by choosing Preferences from the File menu and clearing the 
Confirm on File Deletion check box.

Dialog Box Options

File Name
Displays a list of all libraries or catalogs in the current directory. 

Directories
Displays a list of directories for selecting libraries or catalogs for deleting. Click on a directory, choose 
OK, and all files of a given format within that directory will be shown in the file display screen.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Lists the two choices of file formats available for selection (.CLB for Library files, .CLC for Catalog 
files.)

Drives
Lists the drives available for selection.



Keyword Search dialog box

Locates CorelDRAW files that contain specified keywords and displays their thumbnails on the file display
screen. To locate files by keywords, select a directory, catalog or library, click on the Find button, and 
enter the keywords to use in your search for files. When you have entered your keywords, click on the 
Start Search button. CorelMOSAIC will then display the CorelDRAW files containing those keywords in 
the display screen.

NOTE: To increase the number of directories CorelMOSAIC searches through, click on the subdirectories 
option before selecting this command. All directories below the selected one will also be searched for files
containing the keywords.

Dialog Box Options

Search Criteria
Type up to four keywords (one per box) to use in the search and link each with either an AND or OR 
command. The AND command will cause CorelMOSAIC to display only those files that contain all the 
specified keywords. The OR command will cause all files containing any of the keywords to appear on 
the file display screen.

Start Search
When selected, CorelMOSAIC will begin to search for files containing the specified keywords within 
the directory. Once found, their thumbnails will be displayed in the file display screen.



Print Thumbnails command (File menu)

Prints pages of thumbnail images from within CorelMOSAIC. Use the Page Setup command to select 
formatting options for the pages.

To print the thumbnails for every file in the window you are viewing, choose Print Thumbnails from the File
menu with either all files selected, or no files selected. (If you have no files selected, CorelMOSAIC will 
assume you want to print all the thumbnails).

To print your choice of thumbnails, select the thumbnails you want to print, then choose Print Thumbnails 
from the File menu. (Please note that the Selected button within the Print dialog is automatically enabled 
when you select thumbnails in the window you are viewing). 

NOTE: If you are using the Windows Print Manager, make sure you have enough free disk space to store 
the print file that will be created. You can check the status of your Temp directory by viewing the 
CorelMOSAIC About Box.



Print Setup command (File menu)

Use this command to select the printer and printer options you want to use to print your drawing.

Dialog Box Options

Printer
Selects the default printer or a printer listed in the box under Specific Printer. Only installed printers 
appear in the list. You install printers through the Windows Control Panel.

Orientation
Selects the orientation of the printer page.

Paper
Selects the paper size and source. Click on the arrows on the right of the Size and Source boxes to 
see a list of options you can choose.

Options
Displays a dialog box where you can choose default options for the printer you select. For more 
information, choose the Help button after you choose the Options button.



Page Setup command (File menu)

Displays a dialog box containing options for formatting page titles and file labels for your printed 
thumbnails.

Dialog Box Options
Page Title Alignment
Lists the types of justification (left, right, center) that can be chosen for your page titles.

Directory, Library or Catalog name
Prints the directory, library or catalog name as part of the page title information.

File types
Prints a list of the file types contained in the current directory, library or catalog as part of the page title 
information.

Page numbers
Prints the page number as part of the page title information.

Catalog Description
Prints the text assigned as catalog or library descriptionas part of the page title information.

Custom text
Prints a string of user definable text as part of the title information. 

Font
Indicates which font is currently selected and displays a dialog box for changing the appearance of 
page titles. See Font Dialog Box.

File Labels
Print file name
Prints the name of the file under each thumbnail image. To add the extension, click on the
Include Extension box below this option.
Number of keywords to print
Prints the number of keywords you specify below each thumbnail.

Font
Indicates which font is currently selected and displays a dialog box for changing the 
appearance of your labels. See Font Dialog Box.

Draw frame around page
Puts a frame around each thumbnail image on the page.

Draw frame around thumbnail
Puts a frame around each page of thumbnail images.



Font dialog box

Sets the print style of the titles and labels on the pages of thumbnails.

Dialog Box Options

Font
Lists the different fonts you can choose for your titles. Click on the arrow button to view the range of 
options or type in a selection,

Font Style
Lists type style options such as bold and italic that can be applied to your titles.

Size
Lists the font sizes in points that can be chosen.

Effects
Strikeout prints a line behind all titles.
Underline prints a line under all titles.

Color
Lists the colors that can be applied to your page titles. Click on the arrow button to view the selection 
of colors available.

Sample
Displays a sample of text using the selected font attributes. Immediately below the sample is a short 
description of the type of font displayed.



Preferences command (File menu)

Sets the display format and size of thumbnail images. You can also select operational features, such as 
confirming the deletion of files, within this dialog box.

Dialog Box Options

Thumbnail Size
Portrait Automatically sizes thumbnails taller than wide (133 pixels by 100 pixels).

Landscape Automatically sizes thumbnails wider than tall (100 pixels by 75 pixels).

Square Automatically sizes thumbnails with equal height and width (100 pixels by 100 pixels).

Custom Allows you to define a precise height and width for your thumbnails, as well as the pad 
height and pad width between thumbnails. Thumbnail sizes can be no less than 50 
pixels and no greater than 300 pixels.

Once you have selected a size for your thumbnails, the CorelMOSAIC will indicate how the thumbnails
will print on each page and the printer currently selected.

Confirm on
File Deletion When selected, CorelMOSAIC will display a dialog box asking you to confirm the 

deletion of files within directories, catalogs and libraries.

File Replace When selected, CorelMOSAIC will display a dialog box asking you to confirm the 
replacing of files within directories, catalogs and libraries.

File Copy or When selected, CorelMOSAIC will display a dialog box asking you
Move to confirm the copying or moving of files within directories, catalogs and 

libraries.

Page Color
Allows you to change the display color of the background screen. Click on any color in the palette. The
Define Custom Color option is not operational within CorelMOSAIC.

Text Mode Display
When enabled (a check mark in the box), CorelMOSAIC displays file information (file name, size, date 
and time of last modification and location), in place of thumbnails. 

Font
Displays a dialog box for changing the appearance of thumbnail labels within the file display screen. 
See Font Dialog Box.



Font dialog box

Sets the display style of thumbnail labels on the file display screen.

Dialog Box Options

Font
Lists the different fonts you can choose for your labels. Click on the arrow button to view the range of 
fonts available, or type in a selection.

Font Style
Lists type style options such as bold and italic that can be applied to the labels.

Size
Lists the font sizes in points that can be chosen.

Effects
Strikeout prints a line behind all titles.
Underline prints a line under all titles.

Color
Displays a list of colors that can be applied to your thumbnail labels.

Sample
Displays a sample of text using the selected font attributes. Immediately below the sample is a short 
description of the type of font displayed.



Exit command (File menu)

Closes CorelMOSAIC and returns to Windows. If you use the Exit command in the CorelDRAW mode, 
CorelMOSAIC will close and you will return to the CorelDRAW interface.



Select by Keyword command
(Edit menu)

Allows you to select specific CorelDRAW files within the display screen by entering keywords that are 
associated with each graphics file. After you enter the keywords to use in the search, CorelMOSAIC will 
highlight the files in the display screen that contain the specified terms.

Dialog Box Options

Search Criteria
Type up to four keywords (one per box) to use in the search and choose either the AND or the OR 
command. The AND command will cause CorelMOSAIC to select only those files that contain all the 
selected terms. The OR command will cause all files containing any of the chosen terms to be 
selected in the file display screen.

Start Search
Begins searching for files containing the specified keywords within the selected directory (or 
directories). Once found, the file thumbnails will be highlighted in the file display screen.



Select All command (Edit menu)

Selects all thumbnails in the file display screen simultaneously.



Clear All command (Edit menu)

Deselects any selected thumbnails in the file display screen.



Insert Files command (Edit menu)

Inserts selected thumbnails (files) into a catalog or library of your choice.

Dialog Box Options

File Name
Displays a list of all files of a particular file format in the current directory. The file format is chosen 
from the List Files of Type box.

Directories
Displays a list of directories for selecting the catalog or library where you want to insert your files. 
Select the directory containing the catalog or library you want, select the specific file from the File 
Name box, choose OK, and the files will be added to the library or catalog.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Lists the file formats available for selection. CLB for library files and CLC for catalog files.

Drives
Lists the drives available for selection.

Shortcut
You can copy a new file to a catalog or library by clicking on the file in a directory and dragging it into 
the catalog or library of your choice. If you hold down the Shift key while dragging the file, it will be 
moved instead of copied.

Please note: A file can not be moved into a catalog because a catalog does not contain files, only 
thumbnails.



Expand Files command (Edit menu)

Unarchives a selected file from a library and places it in the directory of your choice. Files within a library 
can not be edited until they have been expanded. You may expand multiple files by selecting a number of 
thumbnails before choosing Expand from the Edit menu but all expanded files will be placed in a single 
directory. Since catalogs contain only thumbnails and a pointer describing the location of the original file, 
you can not expand a library file into a catalog.

Dialog Box Options

File Name
Displays a list of all files of a particular file format in the current directory. The file format is chosen 
from the List Files of Type box. The name of the file you have chosen to expand is highlighted here, 
giving you the option of changing the file name as you expand the file into a new directory.

Directories
Displays a list of directories for expanding your file. Select the directory you want to expand your file 
into, choose OK, and the file will be automatically expanded into the selected directory.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Lists all the file formats available for selection. Click on the arrow button to view the range of file types.

Drives
Lists the drives available for selection.



Confirm file copy dialog box
Displayed when you drag a file from one directory and drop it into another.

You can choose not to have this dialog box appear, by selecting Preferences from the File menu and 
clearing the Confirm on File Copy or Move check box.



Update Catalog command (Edit menu)

Updates thumbnails and file information to reflect changes made to files within a catalog.

Dialog Box Options

Delete files from catalog that no longer exist
Checks path information, confirms files which no longer exist and deletes the appropriate 
thumbnails from the catalog.

Update information for files in the catalog
Updates all file information for thumbnails in the catalog.

Add Files
Displays the view directory dialog box and allows you to select all files in a directory for 
inclusion in the catalog.



 Edit command (Edit menu)
Opens a file into the Corel application associated with that file format. If there is no Corel application 
associated with a particular format, CorelMOSAIC uses the associations specified in the Windows 
Registration Database to allow you to edit files without closing CorelMOSAIC.

NOTE: CorelMOSAIC associates all files with a .DOC extension with Microsoft Word.

Shortcut
Double-clicking on a thumbnail in the file display screen will also open a file in an appropriate 
application.



Import into CorelDRAW command (Edit menu)

Loads graphics files from CorelMOSAIC into CorelDRAW. You can import files into an existing drawing or 
a new drawing window.

NOTE: Unless you specified differently with the Convert Image command, Photo CD images are imported
in Windows BMP format at 768x512 pixels.



Convert from CorelDRAW command (Edit menu)
Opens CorelDRAW and allows you to specify a new file format for your file. If you choose a file with a 
format other than CorelDRAW (CDR), the file will be imported into CorelDRAW where you can then export
it to a new format.

NOTE: In a multi-page document only objects on the currently displayed page (or facing pages if View 
Facing Pages is enabled) will be exported.

Dialog Box Options

File Name
Proposes a name for the export file (the same name as the drawing). Either accept it, or 
type n your own. The file extension corresponds to the Export file format selected from 
the List Files of Type box.
Directories
Select the directory in which the file you want to export is stored.
Drives
Select the drive in which the file you want to export is stored.
List Files of Type
Use to select the type of file you want to export.
About...
Displays the developer and version number of the filter used to export the selected file 
type.
Selected Only
Exports only those objects in the drawing that are currently selected.
OK
Exports the file, or displays another dialog box for the specific filter you are using.



Delete command (Edit menu)

Deletes one or more files from the selected directory, catalog or library.

NOTE: CorelMOSAIC displays a confirmation dialog box before deleting the selected file(s). You can 
choose not to have this dialog box appear, by choosing Preferences from the File menu and clearing the 
Confirm on File Deletion check box.

Dialog Box Options

Delete File
Shows the name of the currently selected file.

Yes
Deletes the currently selected file. If you selected more than one file, CorelMOSAIC will prompt you to 
confirm each deletion.

Yes to all
Deletes all the selected files without prompting you to confirm each deletion.

No
Skips the currently selected file.



Extract Text command (Edit menu)

Copies and saves text within CorelDRAW files in ASCII format, so that you can edit the text without 
having to edit the drawing. This is particularly useful for larger bodies of text. Text from your CorelDRAW 
file is placed in a text file (TXT) with the same name as your graphic file. Once the text has been 
extracted, you can edit the text files using a word processor such as Notepad, then use the Merge-back 
text function to recombine the text and graphic image. In CorelMOSAIC, you can run single or batch 
(multiple) extractions.



Merge-Back Text command (Edit menu)

Updates CorelDRAW files with text revisions after an Extract text operation has been performed.



Keywords command (Edit menu)

Allows you to add or delete keywords associated with CorelDRAW files. These keywords are stored with 
the drawing and are used to locate images with the Select by Keyword command. 

You can change the keywords on one or more graphics files by selecting    the CorelDRAW thumbnails in 
the file display screen, choosing the Keywords command in the Edit menu, and using the Next or 
Previous buttons to step through the different files. 

NOTE: You can not add or delete keywords associated with files that have been compressed into libraries
unless you first unarchive the files.

Dialog Box Options

New Keyword
Box for entering a new keyword that you would like associated with a graphics file.

Current Keyword
Lists all keywords associated with the selected file.

Add
Stores a keyword with the selected graphics file. Type a keyword in the New Keyword box and click 
on the Add button. The new term will appear in the Current Keywords box.

Delete
Eliminates a keyword associated with a graphics file.    Click on a keyword in the Current Keywords 
box that you would like to eliminate and click on the Delete button. 

Update All Selected Files
When chosen, makes changes to the keywords of all selected files simultaneously.



Edit Description (Edit menu)

Allows you to edit the text string you assigned to your catalog when it was created. This description can 
be up to 128 characters, and can be printed with your thumbnails. 

You may only edit the catalog description when you have the catalog open.



Get Info command (Edit menu)

Displays a program icon, a thumbnail, or a large representation of a bitmapped file, as well as relevant file
information. You can get information on one or more files by selecting the thumbnails, choosing the Get 
Info command, and stepping through the file information boxes using the Previous, Next or Cycle 
buttons. 

Shortcut
You can open the File Information box for a single file by double-clicking on the thumbnail using the 
secondary mouse button.

The following items are shown in the File Information box:
· Name of the file
· Path: drive and directory
· Date and time of last modification
· Size: width and height (in pixels) of thumbnails
· Colors: color resolution of the thumbnail image (i.e.    8 bits = 256 colors)
· Graphics file size in bytes
· Bitmap image of the selected file
· Keywords associated with the file (CorelDRAW files only) 
· Notes associated with the file (CorelDRAW files only)
· Fonts used in the file (CorelDRAW files only)



View Kodak Photo CD command
(Photo CD menu)

Allows you to view thumbnails of images stored on a Photo CD disk. When you choose the command, 
CorelMOSAIC automatically checks your system for a CD-ROM drive and asks you to select the 
appropriate drive letter for the Photo CD containing the images.

Once displayed, you can select the images and use the Convert Image command to convert them to 
other file formats. You can also use the Print commands in the File menu to print the images or their 
thumbnails.

Dialog Box Options

Drive
Lists all the drives available to you, including network drives. By default, CorelMOSAIC selects the 
drive corresponding to your CD-ROM. Click on the arrow to the right of the Drives box to view the list 
of drive letters.



Convert Images command (Photo CD menu)

Displays a dialog box where you can select a format and size for converting Photo CD images. Once 
you've made your selections, choosing OK will display another dialog box so that you can specify where 
you want the converted files stored.

Dialog Box Options

File Name
Displays a list of all files of a particular file format in the current directory. The name of the file you 
have chosen to convert is highlighted here, giving you the option of changing the file name as you 
convert the file to a new format.

Directories
Displays a list of directories for placing your new file. Select the directory where you want the 
converted file, choose OK, and the file will be automatically converted and placed into the selected 
directory.

Double-click on a directory to display the related subdirectories and to list all file names of a given 
format in the File Name box. 

List Files of Type
Lists all the file formats available for selection. Click on the arrow button to view the range of file types.
The choice of formats includes three bitmap formats (BMP, PCX and TIFF) and EPS, a vector format 
that page layout programs such a Ventura Publisher and Aldus PageMaker support. 

Drives
Lists the drives available for selection.

Color Depth
Lists the color choices available for selection. You may choose to convert your bitmap image to gray 
scale, black and white, 256 color or 24 bit color.

File Resolution
Lists the resolutions available for selection. You may choose to convert your bitmap image to wallet 
(128 x 192 pixels), snapshot (256 x 384), standard (512 x 768), large (1024 x 1536), or poster (2048 x 
3072) resolution.

NOTE: The amount of disk space required to store the image increases with the image size. Choosing
the largest size, for example, produces a file that's roughly 18 megabytes in size. The time required to 
export the file also increases with image size.      

Shortcut
Double-clicking on a thumbnail exports the image and then opens it in CorelPHOTO-PAINT. Note, 
unless you specified differently with this command, the image will be exported in Windows BMP 
format at 768x512 pixels.



Cascade command (Window menu)

Allows you to arrange open directory and library windows atop one another with each title bar showing.



Tile Horizontally command (Window menu)

Allows you to arrange open library and directory windows side by side in rows so each is visible. The size 
of the windows will vary according to the number open.



Tile Vertically command (Window menu)

Allows you to arrange open library and directory windows side by side in columns so each is visible. The 
size of the windows will vary according to the number open.



Arrange Icons command (Window menu)

Allows you to arrange minimized window icons in a row.



1, 2, 3... (Window menu)

Lists the windows currently open on the file display screen.



Contents command (Help menu)

Displays the opening CorelMOSAIC Help screen. From this screen, you can choose the type of Help you 
want. When you are in Help, clicking on the Contents button takes you back to the opening screen.

Shortcut
· Pressing F1 displays the CorelMOSAIC Help Contents or a Help topic on an open dialog box.
· Pressing SHIFT+F1 then clicking on an active (undimmed) command displays a Help topic on that 

command.



How to use Help command (Help menu)

Displays topics which explain how to use the online Help system. You can access the same information 
from the Help window by choosing the Using Help button or pressing F1.



Search for Help On command (Help menu)

Displays the Help Search dialog box where you can enter keywords to search for and go to a specific 
Help topic. The Search dialog box can also be opened by choosing the Search button from the Help 
window.



About CorelMOSAIC command (Help menu)

Displays a dialog box with information about which version of CorelMOSAIC you are running.



Archiving
The creation of compressed copies of your graphics files into library files. The creation of these 
compressed files does not affect your original graphics files but once your files are successfully archived, 
you may delete the original files to save space on your hard drive. Unarchiving is the process of 
expanding or decompressing files from a library.



ASCII
An acronym for the American Standard Code for Information Interchange, which is a standard code for 
representing characters and non-printable control codes such as carriage returns and page breaks.



Bitmap
An image composed of a series of dots (pixels). Paint programs such as Corel PHOTO-PAINT generate 
this type of image. CorelDRAW creates small bitmapped representations of its vector-based graphics for 
use in file management utilities such as CorelMOSAIC.



Calibration bar
Strips of color printed with an illustration. Used as a reference for calibrating a monitor to 
display colors as they appear in printed output.



Catalog
A master file which stores thumbnails of your files, along with keywords and pointers indicating the 
location of your files. A catalog does not contain the actual files.



Color separation
The process of separating colors in an image into the primary printing colors: cyan, 
magenta, yellow, and black.



Crop marks
Alignment marks at the corners of a page printed on a PostScript printer. Used as aids for 
trimming the paper to the proper size. Crop marks appear only when the page size in 
CorelDRAW is smaller than the paper size of the printer.



Densitometer scale
Printed on each page of a color-separated image for the purposes of gauging the accuracy, 
quality, and consistency of the output.



Direction keys
The arrow keys (¬, ®, , ¯) and the HOME, END, PgUp and PgDn keys on the numeric keypad.



Directory
Like a drawer in a filing cabinet, a directory is part of the structure used to organize files on a disk. 
Directories have names and can have subdirectories existing below them. For example, you could create 
a directory called LOGOS for storing logo designs.    Two possible subdirectories beneath LOGOS might 
be ROUGH and FINAL, for storing your preliminary and finished work, respectively.



Dithered color
Color simulated by putting dots of another color very close together. Windows uses dithering to display 
colors that the graphics adaptor is unable to display.



Double-click
To press and release the primary mouse button twice in quick succession.



Emulsion
The light-sensitive coating material on a piece of film.



Extract text
Command which transfers text from a selected CorelDRAW file into an ASCII text file for editing.



File display screen
The file display screen is the first window you see when you open CorelMOSAIC. It can display open 
windows representing directories, catalog and libraries simultaneously. When you minimize an open 
window, it will be represented at the bottom of the file display screen by an icon unique to its file type. 



File Format
When you save a graphic, it is stored in a particular format by the application. To import a graphic into 
another program, the graphic must be in a format which the other program accepts.    CorelMOSAIC 
recognizes a variety of different graphics file formats including CorelDRAW (CDR), CorelCHART (CCH), 
CorelPHOTO-PAINT (PCX), CorelSHOW (SHW), EPS, and Adobe Illustrator(AI).



Filter
A program that translates information from one format to another.



Fountain fill
A fill that fades gradually from one color to another. Also called a "gradient" or "graduated" 
fill.



Halftone screen
In photography, a sheet of glass or film with a grid pattern of lines used to convert a 
continuous tone image into dots of variuos sizes.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other 
colors. Blue, green, and red, for example, are all hues.



Image setter
A generic term for printers capable of printing text and graphics (line art and photographs) 
at resolutions of about 1200 dots per inch or more.



Inverse
A grouping consisting of the opposite thumbnails than currently selected. For example, if you have the 
third, seventh and twelfth thumbnails selected, choosing inverse would select all thumbnails in the file 
display screen except those three thumbnails.



Keywords
Indexing terms which can be added when CorelDRAW files are saved, or added later using the Keyword 
command in the Edit menu. Keywords can make locating specific files easier. For example, if you have a 
number of graphic files you are using for a project, you might add the keyword Project 1 to each. A 
search on that keyword will locate your files.



Library
A master file which stores individual graphics files in compressed format.



Luminosity
A value corresponding to the brightness of a color.



Menu bar 
The bar near the top of a window that contains the names of the program menus.



Merge-back text
Command which recombines a revised text file with the original CorelDRAW file after an Extract Text 
operation has been performed.



Pad
The space between thumbnail images. The space on left/right of a thumbnail is referred to as Pad Width; 
the space under/above is referred to as Pad Height.



Pixels
Dots of color or shade that together form a graphic image. Paint programs such as Corel PHOTO-PAINT 
use pixels to build graphics whereas CorelDRAW uses vectors to create graphic images. 



Photo CD
A revolutionary process developed by the Eastman Kodak company that converts 35mm film negatives or
slides into digital format and stores them on a compact disc (CD). CorelMOSAIC can open Photo CD 
images and convert them into formats which CorelDRAW, CorelPHOTO-PAINT and other applications 
can import.

NOTE: Photo CD files store multiple resolutions of the image in one large, compressed file. A single Photo
CD file may exceed 8 megabytes of data, which will not be further compressed in a library.



Point 
A unit of measurement relating to the height of a character. A point equals 1/72 of an inch.



Primary mouse button
Normally the left mouse button. If, however, you've swapped mouse buttons using the Windows Control 
Panel, the right mouse button becomes the primary button.



Process color
The primary colors used in four-color process printing: cyan, yellow, magenta, and black.



Registration
Crosshairs or other marks on paper or film used for aligning color separations. Registration marks are 
automatically added when printing color separations to a PostScript printer using CorelDRAW.



Saturation
In the HSB color model, the component that determines the purity or intensity of a color.



Secondary mouse button
Normally the right mouse button. If, however, you've swapped mouse buttons using the Windows Control 
Panel, the left mouse button becomes the secondary button.



Service bureau
A commercial business that prints customer-provided documents or artwork, usually on high-resolution 
PostScript devices.



Spot color
In offset printing, solid colors commonly specified using the PANTONE color matching system. Spot color 
is used whenever exact colors are required.



Thumbnails
Small bitmapped representations of graphic files created and saved with original drawing files. 
Thumbnails are used within CorelMOSAIC as a way of organizing, displaying, and selecting graphics files
visually rather than by filename. 



Title bar 
The bar along the top of a Windows application that contains the name of the application, the Control 
menu box and the Maximize and Minimize boxes. In CorelMOSAIC, the Title bar of each window contains
the path and name of an open library or directory.



Trap
Also referred to as "chokes" or "spreads". The process of adding a slight overlap between adjacent areas 
of color to avoid gaps caused by registration errors.



Window Border
Borders appear around windows that are less than full size. When you move your cursor over a border, 
the cursor becomes a two-directional arrow, and at this point you may drag the border to make the 
window larger or smaller. 

· Drag the top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically and horizontally.

When the window is less than full size, you can also resize it by choosing the Size command from the 
Control menu and using the keyboard arrow keys.



Control Menu

Restore returns the active window to its former size and location.

Move allows you to use the keyboard to move the active window.

Size allows you to use the keyboard to resize the active window.

Minimize shrinks the active window to an icon.

Maximize enlarges the active window to fill the screen.

Close closes the active window.

Switch To lets you switch among currently open applications.



File Menu

New Catalog/Library allows you to create a new catalog or library.

Open Catalog/Library allows you to open an existing catalog or library.

View Directory allows you to select a directory for viewing files.

Delete Catalog/Library deletes a catalog or library you have created.

Print Files opens CorelDRAW and individually prints selected files.

Print Thumbnails prints multiple thumbnail images per page from within CorelMOSAIC.

Print Setup sets printer options from within CorelMOSAIC. 

Page Setup allows you to choose the type and placement of titles when printing thumbnail 
images.

Preferences lets you change the sizing and orientation of thumbnail images and set user 
options.

Exit closes CorelMOSAIC and returns to Windows. In the CorelDRAW mode, the Exit 
command would close CorelMOSAIC and return you to CorelDRAW.



Edit Menu

Select by Keyword locates CorelDRAW files in the file display screen that contain specific 
keywords.

Select All selects all thumbnails in the current directory, catalog or library. 

Clear All unselects all thumbnails currently selected in the directory, catalog or library.

Insert Files allows you to add a file or thumbnail into a library or catalog.

Expand Files extracts and decompresses individual or multiple files from a library.

Update Catalog updates the thumbnails and file information to reflect any changes made to the 
files in a catalog.

Edit opens a file in the Corel application best suited to edit that file format. Files not 
associated with a Corel application will be imported into CorelDRAW. Double-
clicking on a thumbnail in the file display screen will also open the appropriate 
application and display the file.

Convert from CorelDRAW allows you to convert your file to another file format.

Import into CorelDRAW loads graphics files into an existing drawing or a new drawing window within 
CorelDRAW.

Delete eliminates files from a specified directory, or library.

Extract text transfers text from selected CorelDRAW files into ASCII text files for editing. 

Merge-back text updates CorelDRAW files with text revisions after an Extract text operation has 
been performed.

Keywords allows you to add or delete keywords that are associated with    CorelDRAW 
files.

Edit Description allows you to change the text assigned as catalog description.

Get Info displays a larger representation of bitmapped files and information such as file 
size, date last amended and number of colors used. CorelDRAW files also 
show keywords and the fonts used in the file.



Photo CD Menu

View Kodak Photo CD allows you to view    Photo CD images on a CD-ROM disk.

Convert Images converts Photo CD images into other formats so that they can be used in other 
applications.



Window Menu

Cascade layers open windows so that each title bar is visible.

Tile Horizontallyarranges open windows side by side so that all are visible.

Tile Vertically arranges open windows one under the other so that all are visible.

Arrange Icons arranges all minimized window icons in a row.

1, 2, 3... lists all currently open windows.



Help Menu

Contents displays the CorelMOSAIC Help Contents.

How to Use Help explains how to use Help.

Search for Help On displays the Search dialog box which lets you find Help information using 
keywords.

About CorelMOSAIC displays which version of CorelMOSAIC you are using.



CorelMOSAIC Help Contents
To select a category with the mouse, point to a category icon then click. Keyboard users press TAB to highlight the category you 
want, then press ENTER. For more information on using Help, choose the Using Help button or press F1. To return to this screen, 
select the Contents button at the top of the Help window.
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What CorelMOSAIC Does

CorelMOSAIC is an innovative CorelDRAW application designed to display, organize, and manage your 
graphics files.

Main Features
The File Display Screen
The file display screen shows either small bitmapped representations of your graphics files --called 
thumbnails-- or program icons. The option to view thumbnails allows you to select files visually rather 
than by filename only. When you create a drawing in a graphics program such as CorelDRAW, 
thumbnails are saved along with the main image. CorelMOSAIC uses these thumbnails to allow you to
organize and manipulate your graphics files with ease. Graphics files from a variety of different file 
formats can be viewed and managed within CorelMOSAIC. It's best to keep your directories to a 
reasonable size, as there is a limitation on the number of files Mosaic will scan and view - 8000.

To help you make full use of the variety of options available within the program, an information bar is 
provided at the bottom of the screen which identifies the purpose of each function as you move 
through the options in the menus. 

Batch Operations
CorelMOSAIC allows you to perform repetitive tasks on multiple graphics files. You can run batch 
printing, importing, exporting, and extract/merge back text operations. Files can be selected for batch 
operations from within directories as well as libraries and catalogs.

Library function
You can store graphics files from different drives and directories in a filing system called a library. 
CorelMOSAIC automatically compresses all files in a library. Once successfully archived, you can then
delete the original files which saves valuable space on your hard drive for other applications and the 
files they create.

Catalog function
You can also organize your graphics files in a visual filing system called a catalog. CorelMOSAIC 
stores the thumbnails of your files and the locations of the original files within a catalog. This allows 
you to associate files together without moving them around on your drives.

Formatting and printing thumbnail images
This feature allows you to:

· Arrange the orientation of your thumbnail images in the file display screen using 
the Preferences option.

· Assign titles to pages and thumbnail images using the Page Setup option.
· Specify printer options within CorelMOSAIC using the Printer Setup option.
· Print selected thumbnails from a directory, catalog or library of your choice using the Print 

Thumbnails option.



Modes of Operation

You have the option of running CorelMOSAIC in one of two modes:

Standalone Mode accessed by clicking on the CorelMOSAIC icon in the Windows program manager.

Corel Application Mode is accessed by choosing the MOSAIC option from the Open file in each Corel 
application and the Import file in CorelDRAW.

The Cancel! item on the menu bar appears only in Corel Application mode. All other menus (File, Edit, 
Photo CD, Window) are identical to those found in the Standalone mode. 

The following menu commands will be available when you open CorelMOSAIC from within a Corel 
application:

File Menu: New Catalog/Library, Open Catalog/Library, View Directory, Delete Catalog/Library, 
Preferences, Exit

Edit Menu: Select by Keyword, Select All, Clear All

PhotoCD Menu: View Photo CD

Window Menu: All

Help Menu: All



Getting Started

These introductory procedures will get you started using CorelMOSAIC. The first step is learning how to 
select a directory for viewing files in the file display screen. The second step is learning how to select 
thumbnail(s) in the file display screen. Once you have learned these procedures, you can make use of the
variety of file management techniques available through CorelMOSAIC.

NOTE: If you click your mouse button while CorelMOSAIC is loading files, you will halt the loading 
process. If you click your mouse button after the files are loaded, but while CorelMOSAIC is adding 
thumbnails to the file display screen, you will halt the display process. In both cases, hitting the Escape 
(Esc) key on your keyboard will continue the process.

To select a directory:
1. Choose the View Directory command in the File menu. 
2. Choose the type of graphics files that you would like CorelMOSAIC to display by clicking on a file 

format in the List files of Type box.
3. Select a disk drive to search for the desired directory.
4. Click on the Options button to choose additional program features.
5. Select a directory containing graphics files by clicking on a directory in the Directories box and 

choosing OK. All files within that directory of a given file format will be shown in the file display 
screen. Double-clicking on a directory will show all related subdirectories and display the names of 
each file of a chosen format within the File Name box. 

To select thumbnails in the file display screen using a mouse:
1. Position the mouse pointer over a thumbnail image and click on the primary mouse button.

· If you want to select additional thumbnail images, move to a second image, hold down the CTRL
key and click. To deselect individual images, simply click on them with the primary mouse 
button.

· If you want to select a series of adjacent files, click on the first file in the series, hold down the 
SHIFT key, and click on the last file in the series. The files you selected and those in between will
be highlighted.    

· If you want to select all the thumbnails in the file display screen, choose Select All in the Edit 
menu and all thumbnails will be highlighted.

· If you want to deselect any or all of the thumbnails in the file display screen, choose
Clear All from the Edit menu.

2. Click on either the UP or DOWN arrow on the vertical scroll bar to move through the screens of 
thumbnails. You can also use the PGUP or PGDN keys on the keyboard to move to additional 
screens. 



Create a library
You can store selected graphics files in a filing system called a library. Your files will be stored in 
compressed format. Once successfully archived, you can delete the original files, freeing up space on 
your hard drive for other applications. As a rule of thumb, ensure that there is free space available on your
system equal to the total size of all the files you want to archive.
IMPORTANT: If you are creating libraries to compress files and save on disk space, remember you 
should only delete files after they have been successfully archived. Test the libraries you create to make 
sure you can successfully expand any of the images it contains before deleting your originals.

To create a library:
1. Open a directory containing the files you would like to include in your library.
2. Select the thumbnails in the file display screen. 
3. Choose the New Library/Catalog command in the File menu.
4. Choose All Library Files from the List Files of Type box.
5. Select a directory for your new library by clicking on one in the Directories box. Double-clicking on 

a directory will display all related subdirectories and show all libraries within that directory in the 
File Name box.

6. Type in a library name in the bar above the File Name box. 
7. Choose OK.
8. You may now add files to your library by dragging selected thumbnails from a directory window and 

dropping them into the library window. Your library files will automatically be archived to the location
you specified.



Create a catalog
You can link files together without moving them, by grouping their thumbnails and keywords in a visual 
filing system called a catalog. Along with the thumbnails, the catalog will store the location of the original 
files, allowing you to call up the files by double-clicking on the thumbnails.

To create a catalog:
1. Open a directory containing the files you would like to include in your catalog.
2. Select the thumbnails in the file display screen. 
3. Choose the New Library/Catalog command in the File menu.
4. Choose Corel Catalog File (CLC) from the List Files of Type box.
5. Select a directory for your new catalog by clicking on one in the Directories box. Double-clicking 

on a directory will display all related subdirectories and show all catalogs within that directory in the 
File Name box.

6. Type in a catalog name in the bar above the File Name box. 
7. Type a description of your choice in the Description box.
8. Choose OK. 
9. Add files to your catalog by dragging selected thumbnails from a directory window and 

dropping them into the catalog window. The thumbnails and keywords of the files will 
automatically be copied into the catalog.



Perform batch operations
CorelMOSAIC allows you to perform repetitive tasks on consecutive graphics files. You can run batch 
printing, importing, converting and extract/merge-back operations on your graphics files. All files that you 
want to perform the batch operation on must reside on the same drive.

NOTE: Options that you specify for the initial file will apply to all selected files. Batch operations are not 
available when running CorelMOSAIC in Corel Application mode.

To perform a batch operation:
1. Open a directory, library or catalog containing the files you would like to use.
2. Select thumbnails in the file display screen.
3. Choose one of the batch commands such as Print or Import into CorelDRAW. CorelDRAW will 

open, the first image will be displayed along with a dialog box allowing you to specify options 
pertaining to the function.

4. Choose OK and all files will be brought into CorelDRAW sequentially and the tasks performed.



Edit text within files
You can revise or update text in CorelDRAW graphics files using the Extract text and Merge-back text 
commands. You can run single or batch (multiple) operations.

· Extract Text command saves text within CorelDRAW files in ASCII format so that you can edit the 
text without editing the graphic file in CorelDRAW.

· Merge-Back Text command recombines the revised text files with the original image.

NOTE: If you are planning a merge-back operation, keep all text files in the same directory as your 
graphics files.

To extract text from CorelDRAW files:
1. Open a directory.
2. Select thumbnails in the file display screen that you would like to extract text from.
3. Choose the Extract Text command in the Edit menu. 

CorelDRAW will open and display the first image along with a dialog box allowing you to choose a 
directory where you want to put the text extracted from the selected files. All files will then be 
opened sequentially in CorelDRAW and the text extracted and placed in files identified by a TXT 
extension.      

4. Edit the text in a word processor such as NotePad.

To merge back the revised text with the source images:    
1. Select thumbnails in the file display screen that you wish to merge-back.
2. Choose the Merge-Back Text command in the Edit menu. 

CorelDRAW will open and display the first image along with a dialog box allowing you to specify the
directory containing the extracted and revised text files. Once chosen, the text files will be 
recombined with the original images.



Expand library files
Library files contain compressed versions of graphics files. After you have put them in a library, you can 
delete the original files to save room on your hard drive. To open or edit files in a library, they must be 
expanded to full size and placed in a directory. 
Even if files are from different subdirectories, they will be expanded in the one directory location. Once 
you have specified a directory for expanding your files, the program will automatically use this directory 
again for all subsequent expanding tasks in a batch operation.

To expand library files:
1. Open a library.
2. Select thumbnails in the file display screen that you would like to expand.
3. Choose Expand Files from the Edit menu.
4. Choose a directory and drive for the expanded files from the Directories and Drive boxes. 
5. Choose OK.

Shortcut
You can expand a file from a library by clicking on the file in the file display screen and dragging it into 
the directory of your choice.



Format and print thumbnail images
You can format and print pages of thumbnails from within CorelMOSAIC. 

To format the page(s):
1. Open a directory, catalog or library with images to format.
2. Choose Preferences in the File menu.
3. Choose the options you want.    
4. Choose OK.
5. Choose Page Setup in the File menu.
6. Click on the title and file label options you would like to see accompany your printed images.
7. Choose OK and all pages of printed thumbnail images for this operation will be formatted according

to the display and title options you originally specified.

To print the thumbnail images:
1. Choose Print Setup in the File menu.
2. Select the printer options you want.
3. Choose OK.
4. Select thumbnails in the file display screen.
5. Choose Print Thumbnails in the File menu and all selected thumbnails will be printed. 

If no thumbnails are selected, the program will automatically print all thumbnails in the directory or 
library.

NOTE: If you are using the Windows Print Manager, make sure you have enough free disk space to store 
the print file that will be created.



Customize thumbnail size
You can customize the size of your thumbnails and the spacing between them to change the appearance 
of your printed pages.

To customize your thumbnail size:
1. Choose Preferences from the File menu.
2. Select Custom from the list of Thumbnail Size options. You may now enter precise figures for the 

thumbnail size, including height, width, pad height and pad width.
3. Choose OK. 



Import files into CorelDRAW
You can import files from CorelMOSAIC into an existing CorelDRAW graphic or into a new one. If you 
choose a library or Photo CD file to import, you will be prompted for a directory in which to place the 
expanded file before entering CorelDRAW. You can also import a file into CorelDRAW by double-clicking 
on the thumbnail in the file display screen.

To import files into CorelDRAW:
1. Open a directory, catalog or library.
2. Select thumbnails in the file display screen that you would like to import into CorelDRAW.
3. Choose Import into CorelDRAW in the Edit menu and your files will be imported into CorelDRAW. 

Each imported file will consist of a group, making it easy to separate, scale and place in a new 
drawing.

NOTE: If you wish to import the file into an existing CorelDRAW graphic, you must have that CorelDRAW 
graphic already open.



Convert images to other file formats
You can convert your graphics files to different file formats for use in other applications. If you selected a 
library or Photo CD file for converting, you will be prompted for a directory in which to place the expanded 
file(s) before entering CorelDRAW. 
NOTE: When changing the format of more than one file, the initial format you specified will apply to all 
subsequent files in a batch operation.

To convert a graphics file:
1. Open a directory, catalog or library.
2. Select thumbnails in the file display screen that you would like to convert.
3. Choose the Convert from CorelDRAW command in the Edit menu. 

CorelDRAW will open and you will be prompted to enter the file format you would like to change 
your image files to. (For further instructions on how to convert file formats, refer to your CorelDRAW
User's Guide.) 



Search for files 
CorelMOSAIC can locate files using the keywords that are linked to CorelDRAW graphics files. When files
are saved in CorelDRAW, keywords can be specified and linked with the files, making it easy to locate 
them using CorelMOSAIC. 

These keywords can be changed with the Edit Keywords command in the Edit Menu. CorelMOSAIC can 
then be used to either locate files that contain chosen keywords by selecting those files in the file display 
screen, or to display only those files that contain the chosen keywords on screen.

To locate files in the file display screen that contain specified keywords:
1. Open a directory, catalog or library
2. Choose the Select by Keyword command in the Edit menu.
3. Type in the keywords you would like to use in the search separated by either AND or OR.

The AND command will cause CorelMOSAIC to select only those files that contain all the selected 
keywords. The OR command will    cause all files containing any of the chosen keywords to be 
selected in the file display screen. 

4. Click on the Start Search button and the files containing the chosen keywords will be selected in 
the file display screen.

To display only those files containing specified keywords in the file display screen:
1. Choose the View Directory or Open Catalog/Library command in the File menu.
2. Select a directory, catalog or library that you would like CorelMOSAIC to search. 
2. For a directory, click on the Options button within the dialog box.
4. Click on the Find button to begin selecting keywords. 
5. Type in the keywords you would like to use in the search separated by either AND or OR. 

The AND command will cause CorelMOSAIC to display only those files that contain all the selected 
keywords. The OR command will cause all files containing any of the chosen keywords to be 
displayed in the file display screen.

6. Click on the Start Search button and the files containing the chosen keywords will be displayed in 
the file display screen.



Resize the CorelMOSAIC window
You can resize the CorelMOSAIC window so that it takes up more or less space on your screen.

To resize the CorelMOSAIC window with the keyboard:
1. If they are not already displayed, click on  to display CorelMOSAIC's window borders.

2. Press ALT+Spacebar then S.
3. Press the Arrow key that corresponds to the side, top or bottom border you want to move.
4. Press the Arrow keys to move the border.
5. Press the ENTER key when the window is the size you want.

To resize of the CorelMOSAIC window with the mouse:
1. If they are not already displayed, click on  to display CorelMOSAIC's window borders.

2. Do one of the following:
· Drag the side, top or bottom border to resize the window in one direction.
· Drag a corner of the border to resize the window in horizontally and vertically. 

3. Release the mouse button when the window is the size you want.



Control Menu box 

Located at the left end of the Title bar in the CorelMOSAIC and Help windows. Clicking on the Control 
Menu box displays commands for sizing and positioning the window.



Maximize button 

Located in the upper right corner of the CorelMOSAIC and Help windows if they are not fully expanded. 
Clicking on the Maximize button expands the window to fill the entire screen. After you expand a window, 
the button changes to the Restore button . Use this button to return the window to its former size.

· You can also maximize a window by choosing Maximize from the Control menu.
· You can also restore a maximized window to its former size by choosing Restore from the Control 

menu.



Menu Bar 

The horizontal bar near the top of the window contains the names of the available pull-down menus. 
Choose the desired menu by clicking on it, or by pressing the ALT key plus the underlined character in the
menu name. 



Minimize button 

Located in the upper right corner of the CorelMOSAIC and Help windows. Clicking on the minimize button
shrinks the window to an icon at the bottom of the screen. 

· As an icon, the application stays in memory but its window does not take up space on your screen.
· To restore the window, double-click on its icon, or click once on the icon and choose    Restore from 

the Control menu.



Restore button 

Located in the upper right corner of the CorelMOSAIC and Help windows. Clicking on the Restore button 
returns the window to its previous size and location. 

· You can also restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or Size 

commands in the Control menu.



Scroll Bars

Bars along the bottom and right side of the screen used to view portions of a drawing outside the current 
viewing area.

Click on to
An arrow move the current view 10% in selected direction
An elevator move the view a distance of one window size
On a thumb and drag move the view an arbitrary amount in any direction



Title Bar

Located along the top of a window, the Title Bar displays the name of the program and the file you are 
working on. If the window is less than full-size, dragging the Title Bar moves the window around on the 
screen.

The Title Bar may contain the following buttons for controlling the window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Window Border

Borders appear around windows that are less than full size. When you move your cursor over a border, 
the cursor becomes a two-directional arrow, and at this point you may drag the border to make the 
window larger or smaller. 

· Drag the    top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically and horizontally.

With the window less than full size you can also choose Size from the Control menu then use the arrow 
keys to size the window.



How to...
Resize the CorelMOSAIC window



No Help Available
No help exists for the selected item. Either choose another item or press F1 for index of Help topics.



Print Files command (File menu)
Opens CorelDRAW and prints the selected graphics files according to the print options you specify. If you 
are printing more than one file, each will print using the same options. 

Dialog Box Options

Page Window
Shows how a drawing will look when printed. The bounding box surrounding the preview 
image indicates where crop marks will print. To ensure crop marks print with pages of 
thumbnails, you must resize the image to about 80 percent by dragging the handles 
around it. To change its position on the page, click anywhere inside the image and drag. 
For more precision, specify values in the Position and Size boxes.
The rulers allow to you judge the relative size and placement of the image. You can 
change the rulers' units by clicking on the Units box and selecting a new unit from the list.
NOTE: Changing the drawing's size and position does not affect the drawing file, only how
it is printed.

Printer
Shows the active printer and the port it is connected to. If you have other printers 
installed, you can select the one you want to use from the list.
Clicking    displays information about the active printer and it's capabilities.
You can also select installed printers with the Print Setup command.

Print to File
Creates a PostScript file that can be printed from DOS. Commonly used to print files from 
systems which do not have CorelDRAW installed or when sending files to a service bureau
for high-resolution printing. When you choose OK, the Print to File dialog box opens, 
prompting you to type a filename.
Images printed to file always use a default screen frequency of 60 lines per inch. If you 
want to use a different one, specify it using the Screen Frequency setting.
For Mac When printing to file, select this option if you are printing on an image setter controlled by 

a Macintosh computer. Available only with Print to File checked.

Pages
Check All to print all pages in a multi-page document. Or, specify the range of pages you 
want printed in the From and To boxes.

Copies
Prints multiple copies of the current drawing. You can print as many as 10,000 copies, 
depending on the type of printer you are using.

Print Only Selected
Prints only the currently selected objects. Use this option if you want to proof portions of a
complex drawing which takes a long time to print.

Use Color Correction
Check this box to enable the Color button. This permits access to the calibration and 
prepress tools. Color will be closer to the screen representation and to true color. Color 
output may not match those of earlier versions of CorelDRAW.



Options...
Displays the Options dialog box with more advanced options for controlling the way a 
drawing prints.

Color...
Displays a dialog box with controls for preparing drawings for color separation. See Color 
dialog box.

Printer...
Displays a dialog box for selecting a printer and various printer setup options. See Printer 
Setup command.

Position and Size
Lets you adjust the size and position of a drawing with numeric precision. NOTE: Changing
the drawing's size and position does not affect the drawing file, only how it is printed.
Preview Image displays the current drawing in the "page" window.
Fit to Page reduces the drawing to fit on the size of paper in the printer. Use this option 
to proof large drawings that exceed the printer's maximum paper size.
Center centers the drawing on the page.
Tile prints parts of the drawing outside the Printable Page on additional pages. You will 
need to use this option if you are also using the Scale option to print your drawing at a 
size larger than the printer's paper size.
Width, Height adjusts the size of the image. When you change the value in one box the 
value in the other changes proportionately so that the drawing's aspect ratio is 
maintained.
Left, Top adjusts the position of the drawing on the page. The value in the Left box 
represents the location of the top left corner of the drawing. The Top value represents the 
location of the top of the drawing.
Scale Factor resizes the drawing when it is printed. Values below 100 shrink the 
drawing; values above 100 enlarge it. Useful for proofing very small or very large 
drawings. You can use this option to print a single page drawing as a large poster if you 
also enable the Tile option.

Shortcut
Pressing CTRL + P opens the Print Options dialog box



Options dialog box
Use this dialog box to specify how your drawing prints and to access controls for printing 
color separations.

Dialog Box Options

Fountain Steps
Determines the number of stripes printers use to render a fountain fill. Values higher than
40 produce a smooth fountain, but at the expense of longer printing times. 

Set Flatness to
Determines how many segments PostScript printers use to draw a curve. Reducing the 
number of segments helps overcome PostScript limit check errors (which can prevent 
drawings with complex curves from printing). Remember that curves may become 
noticeably rough if the Flatness setting is increased too much.
If you are getting PostScript limit check errors, increase the Flatness setting in increments
of four or five until the drawing prints.

Auto Increase Flatness
Automatically increases the flatness setting in increments of one until the drawing prints. 
If the limit of 10 is reached and a particular object still will not print, the printer will skip 
that object and print the next.

Screen Frequency
Determines the halftone screen frequency used to print your drawing. 
If you are printing color separations, you can adjust the screen frequency of each of the 
CMYK colors in the Separations dialog box.

Print Negative
Creates a reversed image of the drawing for printing on an image setter that images 
directly on film. This option is selected automatically when you choose Print As 
Separations. If you are not printing to film, deselect Film Negative.

Emulsion Down
Select when printing to film if you want the drawing to print emulsion side down.

All Fonts Resident
Prints text in the drawing using the printer's resident PostScript fonts rather than 
CorelDRAW's. Use this option if you are sending your work to a service bureau that has 
Adobe versions of the fonts you have used. If the font is not resident in the printer, the 
text will print in Courier, or the drawing will not print.

Print as Separations
Prints each Process color component or Spot color used in the drawing on a separate 
page. The Crop Marks, Print Negative and File Information options are checked 
automatically.

Separations
Available when Print As Separations is checked. Click on it to display another dialog box 
with controls for preparing the drawing for color separation. See Separations dialog box.



References
Adds standard printers' marks and file information to your drawing when you check the 
appropriate options.
NOTE: For references to appear, the size of the Printable Page must be smaller than the 
size of the page you are printing on.
Crop Marks
Prints crop marks to the printed page. If you are printing color separations, the color, 
screen angle and density for each page are also printed.
Calibration Bar
Prints calibration bars for each color in the drawing.
Registration Marks
Prints registration marks on each page of a color separated drawing.
Densitometer Scale
Prints a densitometer scale on each page of a color separated drawing.
File Information
Prints the filename of the drawing, the screen frequency, and the current date and time 
outside the left margin of the Printable Page. Also includes the color name and screen 
angle when printing color separations.

If the size of the Printable Page exceeds the size of the paper you are printing on, the file info 
will not appear. In this case, use the Within Page option if your Printable Page is 8.5x11 inches.

For larger page sizes, use the File Page Setup command to define a custom page size that is 
smaller than the printer paper. You may then have to resize your drawing to fit on the new page 
size.



Separations dialog box
Use this dialog box to prepare a drawing for color separation. After specifying settings here, 
you can access the Prepress tools dialog box which contains controls for enhancing the 
quality of the printed image.

Dialog Box Options

Print Separations in Color
When checked, prints the separations in color rather than grayscale. This option is 
available if you are printing to a color printer or if you are printing to file. Printing on 
transparencies with this option enabled will allow you to check any traps you've applied 
to objects in your drawing.

Convert Spot to CMYK
Converts spot colors in the drawing to their process color equivalents.
NOTE: While the converted color appears the same on screen, it will not match the Spot 
color exactly when printed.

Colors
Lists the four process colors (cyan, magenta, yellow and black) and any spot colors used 
in the drawing. Click on the colors for which you want to print separations.
Select All Prints separations for all colors.

Clear All Deselects all colors.

Auto Trapping
Adds trap to certain objects in your drawing.

Always Overprint Black Adds trap to any object that contains 95 percent black. 

Auto-Spreading Adds trap to all objects which meet three conditions: they have no 
outline, they are filled with a uniform color and they have not already 
been designated to overprint via the Overprint Fill command in the 
CorelDRAW Object menu.

In the Maximum box, specify the maximum amount of trap you want to 
add. The actual amount added depends on the object's color: the lighter 
the color, the greater the percentage of the maximum value CorelDRAW 
adds.

If Always Overprint Black is also checked, black overprinting will occur 
even if the object does not meet the three conditions for auto-trapping.

Screen Angles and Frequencies
Controls the screen angles and frequencies for each of the four Process colors. 

Use Custom Halftone Select this option if you want to specify halftone screen angles and line 
frequencies for each of the CMYK colors. If left unchecked, your drawing 
prints using the printer's default angle and frequency.



Color dialog box
Use this dialog box to compare your drawing with a version adjusted according to settings in
the current Color Circuit. Another dialog box accessed from this one, allows you to change 
the settings to fit particular image characteristics and print production requirements.

Dialog Box Options

Original, Preview
Shows the original unadjusted image on the left and the color-corrected image on the 
right. The name of the circuit used to adjust image appears in the dialog box's title bar.
You can magnify the original and preview images by clicking their respective    buttons. 
Drag the box in the Original window to select the area you want to magnify.

Colors
Lists the colors in your image. Select or deselect the desired CMYK plates to view 
progressive press proofs on screen. Those you select will be combined and displayed 
accordingly in the Preview window. Selecting and deselecting colors here has no affect on 
the printed image.
Show as Grayscale Select to preview the image in 256 color grayscale. This option is 

only available when only one of the four CMYK plates is enabled.
Select All Click to select all colors.
Clear All Click to deselect all colors.

Circuits
Displays dialog boxes for loading, modifying and viewing information on Color Circuits.
Load Displays another dialog box in which you can specify the Color Circuit you 

want to modify. See Load Circuit dialog box.
Save Displays another dialog box so that you can save the modified circuit settings as a new 

circuit. See Save Circuit dialog box.

Info Displays information on the current Color circuit.

Prepress Displays another dialog box with controls for modifying and creating Color circuits. See 
Prepress Tools dialog box.



About Color Circuits
Color Circuit (.SMT) files are editable files that contain color separation controls for setting 
parameters which prepare the image for separation. An .SMT circuit includes six parameters 
that you can modify using the Prepress Tools dialog box. The parameters are as follows:

· Output Device Calibration
· Undercolor Removal (UCR)
· Black Point Generation
· Gray Component Replacement (GCR)
· Press and Paper Dot Gain
· Color Separation Quality

Opening the Color dialog box, loads the default .SMT circuit that comes with CorelDRAW. When you 
configure the circuit by modifying any of the parameters in the Prepress Tools dialog box, you must save 
the modified circuit under a new name. You can configure and modify the default. SMT circuit over and 
over again, and save and reuse as many of them as you need to fit different image characteristics and 
prepress application requirements.

See also
Prepress Controls



Prepress Tools dialog box
Use this dialog box to adjust Color Circuit settings which prepare the image for color printing
or separation. An .SMT Circuit must be created before you print the image. This means you 
must use (or modify) the default circuit included with CorelDRAW.
After modifying the default circuit and clicking OK another dialog box will appear where you 
can give the modified circuit a new name.

Dialog Box Options

Circuit
Shows the name and location of the current circuit.

Gray Component Replacement (GCR)
Sets the amount of GCR. Drag the tonal range handles on the GCR graph up or down to 
set the desired level. The value at the top of the selected tonal range changes 
accordingly.

Dot Gain
Adjusts halftone dot size to compensate for the dot gain produced by web, offset and off 
press proofs. Select the option that corresponds to the type of press you plan to use.
Select the desired CMYK channel from the Dot Gain list box. You can set the dot gain 
percentage for all four CMYK channels separately, or all at once by selecting Master from
the list box. Enter the amount of gain for the selected channel in the text box. (The most 
typical percentages are between 18% and 24% for web, offset and off-press proofs alike.

Quality
Determines the quality of the color separation. Choose Better if you are printing a proof 
copy of your graphic. Choose Best when you're printing your final copy.

UnderColor Removal (UCR)
Adjusts the amount of UCR. Select the desired UCR value by dragging the slide bar or by 
entering the value in the text box. 
Film, Printer Indicate whether you are ouputting to film or directly to an imagesetter by 

selecting Film or Printer.
Black Point Set the desired Black Point value by clicking the up or down arrows or by 

entering the value in the text box.

Load, Save
These buttons are always dimmed.

Calibrate...
Displays another dialog that allows you to match the colors on your monitor to the printed
output. See Calibrate dialog box.

See also
Prepress Controls



Load Circuit dialog box
Use this dialog box to specify the Color Circuit you want to use with a drawing.

Dialog Box Options

File Name
Either type the name of the circuit you want to open or select it from the list.

Drives
Select the drive in which the circuit you want to open is stored.

Directories
Select the directory in which the circuit you want to open is stored.

List Files of Type
Shows Color Circuit (*.SMT) as the type of file to be opened.



Save Circuit dialog box
Use this dialog box to save changes you've made to the Color Circuit settings in the Prepress
Tools dialog box.

Dialog Box Options

File Name
Type a name for the new circuit. Use the current name or select a name from the list if 
you want to overwrite an existing circuit.
The filename precedes the .SMT extension and can contain up to eight characters.

Drives
Select the drive in which you want the file stored.

Directories
Select the directory in which you want the files stored.

List Files of Type
Shows Color Circuit (*.SMT) as the type of file to be saved.



Prepress Controls
Choose the control you want to learn more about.
Gray Component Replacement (GCR)
Undercolor Removal (UCR)
Black Point
Dot Gain



Gray Component Replacement (GCR)
A technique for reducing the cyan, magenta and yellow in an image and replacing them with
an appropriate amount of black.
When you use GCR, separations will print with improved sharpness, better color fidelity, and 
increased contrast. They will also print with better consistency during the print run. Using 
GCR in an .SMT circuit is not critical to producing a quality separation. However, GCR can 
make quality separations even better, especially for darker images or those that contain 
considerable amounts of problem colors such as purples, browns, deep reds, flesh tones, and
grays.
CorelDRAW's GCR tool allows you to set the GCR to different levels along the tonal range. 
You produce skeletal blacks by setting the GCR level to very low values near the highlights, 
and to higher values in the shadows. Because high levels of GCR reduce the total amount of 
ink, deep shadow and black areas may appear to be less glossy and have less depth. You 
can compensate for this by using less GCR in the shadow areas.



Undercolor Removal (UCR)
UCR refers to the reduction of the cyan, magenta and yellow colors in the dark or neutral 
shadow areas to reduce the total amount of ink coverage. In an ideal printing environment, a
press would be able to print any combination of ink densities, up to 100% of each of the four
colors, or what is known as 400% TAC (Total Area Coverage). However, the maximum 
generally accepted TAC is 300%. TAC values higher than the maximum generally cause 
problems with black ink transfer, ink drying, and ink trapping.



Black Point
A black produced by 100% of each of the CMYK components is darker than one produced by 
full amounts of CMY. The black point specifies the blackness level relative to these two 
references in a range from 0 to 1.0. A black point of 0.0 yields a black as dark as a 3-color 
black (CMY). A black point of 1.0 yields a black as dark as a full 4-color black (i.e., darker).
NOTE: The black point only specifies the apparent darkness of black. The actual CMYK 
percentages used to produce this appearance is determined by the GCR and UCR settings in 
the Prepress Controls dialog box.



Dot Gain
Halftone dots that make up an image gain in size from the time you view them on film to the
time they come off the press. This unavoidable increase in size results in colors that appear 
more intense in the printed image than intended. Fortunately, dot gain can be compensated 
for during the color separation process.
Factors that contribute to dot gain are the quality of the paper, especially its absorbency; the
properties of the ink, and the capabilities of the printing press.
CorelDRAW's Dot Gain control can compensate for all four colors separately (CMYK), or for all
four collectively (Master). The compensation technique reduces the size of a given pixel in 
the image to compensate for the fact that the same dot will increase in size on the printing 
press. For example, a pixel having a density value of 60% when measured before printing 
might have a measured value of 70% when printed on paper. If you want to maintain the 
60% value, the value must be reduced such that the increase caused by dot gain will result 
in the desired 60% dot. So when you calculate a dot gain and then apply a percentage, you 
enter a positive number that represents the percentage of decrease that you wish to apply 
to the pixels in that channel(s). 



Calibrate dialog box
Use this dialog box to match the six primary colors on your monitor with their printed 
equivalents. Matching them ensures that the colors you see on your monitor will look as 
much as possible like those in your printed output. Setting the calibration values is a critical 
step in making a Color Circuit.
Clicking on a color displays another dialog box with controls for calibrating that color. See 
Color dialog box.
NOTE: If you work with different CMYK devices (i.e., imagesetter, proof printer, or matchprint
system), you'll probably need to specify color calibration values for each device. 



Color dialog box (Calibration)
Use this dialog box to calibrate colors selected in the Calibrate dialog box.
You calibrate a color by adjusting its hue, saturation, and luminosity or by specifying its red, 
green, and blue values.

Dialog Box Options

Basic Colors
Displays a palette of preset colors available for your screen. You can begin the calibration 
process by selecting the color that most closely matches the color you are calibrating 
(i.e., the color you are changing) then using the Color Picker to adjust it.

Custom Colors
Displays a palette of colors you selected with the Color Picker.

Define Custom Colors...
Displays a Color Picker for creating and refining colors.

Color Picker
Drag the cursor to the area of the box that shows the printed color you are trying to 
match. Or type values in the Hue and Sat boxes. To adjust the color's luminosity, drag the 
cursor in the narrow box. Or type a value in the Lum box.

Color/Solid Box
The left side of the box show the color selected in the Calibrate dialog box. The right side 
shows the color selected in the Color Picker.

Hue, Sat, Lum
Shows numeric values for the selected color's hue, saturation and luminosity. As you drag
the cursors in the Color Picker, the values change accordingly. You can also type values in 
these boxes or click the arrows to increase or decrease them.

Red, Green, Blue
Shows numeric values for the red, green and blue components of the selected color. As 
you drag the cursors in the Color Picker, the values change accordingly. You can also type 
values in these boxes or click the arrows to increase or decrease them.

Add to Custom Colors
Click to add the calibrated color to the selected square in the Custom Colors.



Print to File dialog box
Use this dialog box to give a name to a file you want to print to disk.

Dialog Box Options

File Name
Type a name for the file. If you want or overwrite an existing file, select its name from the 
list.
The file name precedes the .PRN extension and can contain up to eight characters.

Drives
Select the drive to which you want the file printed.

Directories
Select the directory in which you want the file printed.

List Files of Type
Shows Print File as file type being created.

Read Only
Select this option to prevent the file from being overwritten or altered.




